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Versionsnoter til QuarkXPress og QuarkXPress Passport 4.1 ‘

AR

Dette dokument indeholder oplysninger om a&ndringer

og tilfgjelser til QuarkXPress™-, QuarkXPress Passport™- og
QuarkXTensions™-software siden ferdiggorelsen af “En vejled-
ning til QuarkXPress 4.1”. “En vejledning til QuarkXPress
4.1” findes som PDF-arkiv pd QuarkXPress 4.1- eller Quark
XPress Passport 4.1-cd-rom’en.

. Supplerende sprog til QuarkXPress Passport
. Allerseneste oplysninger
. Sadan kontakter du Quark

. Juridiske oplysninger
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Supplerende sprog til QuarkXPress Passport

Orddeling er tilgeengelig for supplerende sprog i QuarkXPress
Passport. Disse omfatter tjekkisk, finsk, graesk, ungarsk, polsk og
portugisisk til Mac OS samt finsk, ungarsk, polsk og portugisisk
til Windows.

Der medfglger supplerende sprog pa opdaterings-cd-rom’en til
QuarkXPress Passport 4.1. De er ogsa tilgeengelige pd en separat
cd-rom med supplerende sprog. Du kan fa oplysninger om, hvor-
dan du fér en cd-rom med supplerende sprog, ved at kontakte dit
naermeste Quark™-kontor eller en autoriseret Quark-forhandler
(se afsnittet “Sddan kontakter du Quark” i dette dokument).
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mangden af hukommelse i feltet Onsket str., og luk dialo-

Allerseneste oplysninger

BEMZARK Der er muligvis medtaget yderligere rettelser eller
afslgret andre problemer efter udgivelsen af dette dokument.
Du kan fa aktuelle oplysninger om kendte problemer ved at
besgge omradet med teknisk support pa Quarks websted pa
adressen www.quark.dk.

Yderligere oplysninger om QuarkXPress 4.1

¢ (Kun QuarkXPress Passport til Mac OS) Hjealp-arkiverne til
QuarkXPress Passport er blevet opdateret i version 4.1. Du
kan opdatere disse arkiver ved at dbne mappen “Passport
Help Files” pa QuarkXPress Passport-opdaterings-cd-rom’en.
Find Hjaelp-arkivet til det gnskede sprog, og traek det over i
QuarkXPress Passport-programmappen pa computerens

harddisk. Hvis der allerede er installeret et a&eldre Hjaelp-arkiv

til det pdgaeldende sprog, skal du erstatte det gamle Hjeelp-
arkiv med det nye.

¢ (Kun Mac OS) Ud over udvalget af QuarkXTensions-moduler,
der leveres af Quark, indeholder QuarkXPress-cd-rom’en mange

gratis XTensions™-moduler og XTensions-demomoduler fra

andre producenter. Hvis du installerer mange XTensions, bli-
ver du sandsynligvis nadt til at forage hukommelsesallokerin-

gen til QuarkXPress. Dette gor du i Mac OS 8.1 eller tidligere
ved at fremhave QuarkXPress-programsymbolet og valge
Arkiv - Vis info eller trykke pa & +I. I Mac OS 8.5 eller

senere skal du fremhave QuarkXPress-programsymbolet og
veelge Arkiv > Vis info ~ Hukommelse eller trykke pa 6+1
og veelge Hukommelse pa lokalmenuen Vis. Forgg derefter

gen Info.

(Kun Mac OS 9) Hvis en bruger, der er defineret som Limited
User (8 > Control Panels -~ Multiple Users) (Begraenset
bruger > Kontrolpaneler > Flere brugere), har adgang til
en tidligere installeret kopi af QuarkXPress 4.x og forsgger at
starte den, mens QuarkXTensions-software som ikke er skre-
vet til 4.0 er installeret, indlaeses QuarkXTensions-software
ikke, der vises en fejlmeddelelse, og QuarkXPress verktojerne
inaktiveres. For at anvende QuarkXPress pa en Limited User-
account skal du geninstallere QuarkXPress pa Limited Users
skrivebord eller brugermappe. Nar forst QuarkXPress er gen-
installeret med Limited Users logon, starter QuarkXPress kor-
rekt med QuarkXTensions-software som ikke er skrevet fil 4.0.

(Kun Windows NT 3.51) Der kan opstd forskellige proble-
mer med visningen, nadr du kerer QuarkXPress 4.1 med
Windows NT 3.51.

Yderligere oplysninger om QuarkXTensions-softwaren PDF
Filter

Side 4

I afsnittet om PDF Filter 1.3 i “Guide til QuarkXPress 4.1”
indeholder de to sidste afsnit af trin 6 under “Indstilling af
valg til trykning af PDF-arkivet” forkerte oplysninger. Se bort
fra disse to afsnit.

Data i omradet Flere oplysninger i dialogen Brug under
fanen Billeder (menuen Ekstra) vises muligvis forkert, nar
PDF Filter indlaeses.
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e PDF Filter kan ikke importere PDF-arkiver, der indeholder Yderligere oplysninger om QuarkXTensions-softwaren
indlagte 2-byte skrifter af CID-typen (japansk, koreansk eller DejaVu
kinesisk). e (Kun Mac OS 8.x) Hvis du vil aktivere en standardsti for menu-

kommandoerne under Arkiv, skal du afslutte QuarkXPress
og derefter vaelge Kontrolpanel -~ Generelt pd menuen Apple
(®) og Kklikke pé alternativknappen for enten Mappe der et
oprettet af programmet eller Mappen Dokumenter i omra-
det Dokumenter. Klik derefter pa lukkefeltet for dialogen
Generelt, og start QuarkXPress igen.

¢ (Kun Mac OS 8.5.1) Der er en inkompatibilitet mellem
Mac OS 8.5.1, TrueType-skrifter og LaserWriter 8.2.2 drivere
eller tidligere eller Adobe® PSPrinter™ 8.3.1-drivere. Nar der
eksporteres et PDF-arkiv med TrueType-skrifter i Mac OS 8.5.1,
kan computeren ga ned, ndr du bruger en af disse drivere.

Yderligere oplysninger om QuarkXTensions-softwaren

QuarkLink

e Der er grenser for, hvor stor en e-mail, du kan sende med
QuarkLink™-softwaren. Graensen er 32 K (32.766 tegn). Hvis
du nar denne graense, kan der ikke indtastes mere tekst i dia-
logen E-mail. Hvis du forseger at indsette tekst, der oversti-
ger denne graense, i dialogen E-mail, indsatter QuarkLink sa
mange tegn, det er muligt, for tekstgraensen nés.

e Nar du @ndrer standardindstillingen for arkivlisten, vises
der muligvis dubletter af de seneste abnede dokumenter,
nér du dbner dem via enten arkivlisten eller Arkiv >~ Abn.
Du kan lgse dette problem ved at slette arkivet “Dejavu.prt”,
der ligger i Systemmappe > Valg pa Mac OS eller i map-
pen “XTension” i QuarkXPress- eller QuarkXPress Passport-
programmappen pa Windows.

Yderligere oplysninger om QuarkXTensions-softwaren

Guide Manager

e Hvis du indtaster ugyldige oplysninger i et af felterne under
fanen Add Guides (Tilfoj hjaelpestreger) i dialogen Guide
Manager og derefter klikker pa Add Guides (Tilfoj hjaelpe-
streger), viser QuarkXPress muligvis dialogen Guide Mana-
ger, uden at der vises en fejlmeddelelse om, at de oplysninger,
du har indtastet, er ugyldige.

Yderligere oplysninger om QuarkXTensions-softwaren

Custom Bleeds

e ] et dokument med modstdende sider, genererer indstillingerne
i felterne Indvendig og Udvendig (Arkiv - Udskriv - fanen
Beskeering) ikke korrekte indvendige og udvendige beskaerin-
ger, ndr Opslag markeres i dialogen Udskriv under fanen
Dokument.
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e Hvis du klikker pa Remove Guides (Fjern hjeelpestreger) og
derefter klikker pd Cancell (Annullér) ndr All Spreads (Alle
opslag) er valgt pa lokalmenuen Where (Hvor) (Ekstra >
Guide Manager > fanen Remove or Lock Guides (Fjern eller
13s hjeelpestreger) - omrddet Remove Guides (Fjern hjeelpe-
streger)), fjernes nogle hjalpestreger. Dette sker kun i doku-
menter med modstaende sider, der bestar af over fire sider.

Yderligere oplysninger om QuarkXTensions-softwaren

Scissors

e Hvis du klipper et felt, der indeholder indekseret tekst, fjer-
nes alle indekserede ord i det pdgaldende felt fra paletten
Stikord.

¢ (Kun Windows) Hvis du klipper flere gange i et lodret segment
af et billedfelt, vises stregerne mellem klippene muligvis ikke
leengere, men du kan stadig vaelge dem. Du kan lgse dette
problem ved at rotere feltet en lille smule, inden du klipper
segmentet.

Yderligere oplysninger om QuarkXTensions-softwaren

Super Step and Repeat

¢ (Kun for supplerende sprog i QuarkXPress Passport) Hvis du
bruger Super Step and Repeat, mens programsproget er ind-
stillet til et supplerende sprog (Redigér - Programsprog),
far det QuarkXPress Passport til at haenge. Du kan lgse dette
problem ved at skifte programsprog til et standardsprog i
QuarkXPress Passport, inden du valger Objekt >~ Avance-
ret gentagen dublering.

m Side 6
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Sadan kontakter du Quark

Hvis du er underlagt en kundestgtteplan, kan du kontakte dit
lokale Quark-kontor eller Quark-distributer.

For en liste over Quark-kontorer og Quark Full Service distributerer,
se arkivet med teknisk support pa din QuarkXPress CD-ROM.

Klik pd “Sddan kontakter du Quark” pa Quarks web-sted pa
adressen www.quark.dk, hvis du gnsker en opdateret oversigt
over Quarks kontorer og autoriserede Quark distributerer.

For produktoplysninger besgg Quarks web-sted pa
www.quark.dk.

For e-post support til QuarkXPress Passport, send en
besked til techsupport@quark.dk, MacTech@quark.com
eller WinTech@quark.com.

m Side?7
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Juridiske oplysninger

©1999 Quark Technology Partnership mht. indholdet og arran-
gementet af dette materiale. Alle rettigheder forbeholdes.

©1986-1999 Quark Technology Partnership mht. til teknologien.
Alle rettigheder forbeholdes.

Oplysningerne i dette dokument ma ikke andres, distribueres
eller formidles pa papir eller i elektronisk form uden forudgdende
skriftlig tilladelse fra Quark Technology Partnership eller dennes
licenstager Quark, Inc.

Oplysninger om varemaerker

Quark, QuarkXPress, QuarkXPress Passport, XTensions og
QuarkXTensions er varemerker, som tilherer Quark, Inc. og
alle relevante associerede selskaber, Reg. U.S. Pat. & Tm. Off.
og i mange andre lande. Quark-logoet, QuarkLink og andre vare-
meerker, som Quark, Inc. mdtte tage i brug fra tid til anden, er
varemaerker, der tilhgrer Quark, Inc. og alle relevante tilknyttede
selskaber.

Adobe og PSPrinter er varemaerker, som tilhgrer Adobe Systems
Incorporated.

Alle andre varemeaerker tilhorer de respektive ejere.

m Side8
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Dieses Dokument enthilt Informationen zu Anderungen und
Erweiterungen fiir QuarkXPress™, QuarkXPress Passport™ und
QuarkXTensions™ Software seit der Fertigstellung von , Quark
XPress 4.1 zum Nachschlagen”. Dieses Handbuch ist im PDF-
Format auf der QuarkXPress 4.1 oder QuarkXPress Passport 4.1
CD-ROM enthalten.

. Zusatzsprachen fiir QuarkXPress Passport
. Allerletzte Informationen
. Quark kontaktieren

. Rechtliche Hinweise
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Zusatzsprachen fiir QuarkXPress Passport

Zusatzsprachen mit entsprechender Silbentrennung sind fiir Quark
XPress Passport in Tschechisch, Finnisch, Griechisch, Ungarisch,
Polnisch und Portugiesisch (Mac OS) bzw. in Finnisch, Ungarisch,
Polnisch und Portugiesisch erhiltlich (Windows).

Die Zusatzsprachen sind auf der QuarkXPress Passport 4.1
Updater CD-ROM enthalten und kdonnen zudem {iiber eine
separate CD-ROM bezogen werden. Falls Sie an der CD-ROM
mit den Zusatzsprachen interessiert sind, wenden Sie sich an
Ihre Quark™ Niederlassung oder Ihren Quark Distributor (siehe
,Quark kontaktieren” in diesem Dokument) .

- seite 0 I I 1
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Allerletzte Informationen

HINWEIS Moglicherweise wurden in letzter Minute noch
Probleme behoben oder entdeckt, die hier nicht dokumentiert
sind. Allerletzte Informationen zu bekannten Problemen finden
Sie im Bereich fiir Tech Support auf der Quark Website unter
www.quark.de.

Zusatzliche Informationen zu QuarkXPress 4.1

e (Nur QuarkXPress Passport fiir Mac OS) Die QuarkXPress
Passport Hilfedateien wurden fiir die Version 4.1 aktualisiert.
Um die Dateien auf den neuesten Stand zu bringen, 6ffnen
Sie den Ordner "Passport Help Files" auf der QuarkXPress
Passport Updater CD-ROM. Suchen Sie die Hilfedatei fiir Ihre
Sprache, und ziehen-kopieren Sie sie in den QuarkXPress
Passport Anwendungsordner auf Ihrer Festplatte. Wenn dort
bereits eine dltere Version der Hilfedatei installiert ist, erset-
zen Sie diese durch die neue Datei.

e (Nur Mac OS) Die QuarkXPress CD-ROM enthilt neben zahl-
reichen QuarkXTensions Modulen auch kostenlose und Demo
XTensions™ Module von Drittanbietern. Je mehr XTensions
Module Sie ausfiihren, desto mehr Speicher sollten Sie Quark
XPress zuweisen. Markieren Sie dazu unter Mac OS 8.1 oder
frither das QuarkXPress oder QuarkXPress Passport Anwen-
dungssymbol und wiéhlen Sie Ablage > Information oder

driicken Sie 38 +I; unter Mac OS 8.5 oder hoher markieren Sie
ebenfalls das QuarkXPress oder QuarkXPress Passport Anwen-
dungssymbol, wahlen Sie Ablage - Information - Speicher
oder driicken Sie 3+ und wihlen Sie Speicher im Popup-
Menii Anzeigen. Erhohen Sie die Zahl im Feld Bevorzugte
Grofde und schliefien Sie die Dialogbox Information.

(Nur Mac OS 9) Wenn ein eingeschrankter Benutzer (im
Kontrollfeld fiir ,Mehrere Benutzer” festgelegt) Zugriff auf
ein zuvor installiertes Exemplar von QuarkXPress 4.x hat
und dieses starten mochte, wihrend nicht 4.0-native Quark
XTensions Software installiert ist, schldgt das Laden dieser
QuarkXTensions Software fehl. Es wird eine Fehlermeldung
angezeigt, und die QuarkXPress Werkzeuge sind deaktiviert.
Zur Verwendung von QuarkXPress mit einem eingeschrank-
ten Benutzerkonto miissen Sie QuarkXPress auf dem Desktop
oder im Benutzerordner des entsprechenden Benutzers neu
installieren. Nach der Neuinstallation von QuarkXPress mit
der Anmeldung des eingeschridnkten Benutzers wird es kor-
rekt mit der nicht 4.0-nativen QuarkXTensions Software
gestartet.

(Nur Windows NT 3.51) Beim Ausfithren von QuarkXPress
4.1 unter Windows NT 3.51 kann es zu verschiedenen
Anzeigeproblemen kommen.

Seite 11 Cwvww | “inbatt ]
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Zusatzliche Informationen zur PDF Filter QuarkXTensions

Software

e Im Abschnitt ,PDF Filter 1.3“ in ,QuarkXPress 4.1 zum
Nachschlagen” sind die letzten beiden Absdtze in Schritt 6
unter , Vorgaben fiir den PDF-Druck festlegen” fehlerhaft.
Bitte ignorieren Sie diese.

e Mit geladenem PDF Filter werden im Bereich Weitere Info.
im Register Bilder der Dialogbox Verwendung (Ment Hilfs-
mittel) unter Umstdnden ungenaue Informationen angezeigt.

e Der PDF Filter kann keine PDF-Dateien mit eingebetteten
CID-Doppelbyte-Schriften importieren (Japanisch, Koreanisch
und Chinesisch).

e (Nur Mac OS 8.5.1) Es besteht eine Inkompatibilitdt zwischen
Mac OS 8.5.1, TrueType Schriften und LaserWriter 8.2.2 Trei-
bern (oder friiher) bzw. Adobe® PSPrinter™ 8.3.1 Treibern.
Beim Exportieren einer PDF-Datei mit TrueType Schriften
unter Mac OS 8.5.1 mit einem dieser Treiber kann es zum
Absturz kommen.

Zusatzliche Informationen zur QuarkLink QuarkXTensions

Software

e Mit der QuarkLink™ Software gesendete eMails sind auf 32K
(32.766 Zeichen) begrenzt. Wenn dieses Limit erreicht ist,
nimmt die Dialogbox eMail keinen weiteren Text auf. Wenn
Sie tiberlangen Text in dieser Dialogbox einsetzen, gilt dieselbe
Beschrankung.

Zusatzliche Informationen zur Custom Bleeds
QuarkXTensions Software

Wenn Sie in einem Dokument mit Doppelseiten in der Dia-
logbox Drucken im Register Dokument die Checkbox Mon-
tageflachen markieren und im Register Anschnitt Werte fiir
Innen und Aufden angeben, wird dieser Anschnitt nicht kor-
rekt wiedergegeben.

Zusatzliche Informationen zur DejaVu QuarkXTensions
Software

(Nur Mac OS 8.x) Um einen Standardpfad fiir Befehle im
Menii Ablage anzugeben, miissen Sie zundchst QuarkXPress
beenden, im Mentii Apple (8) Kontrollfelder - Allgemeine
Einstellungen wihlen und im Bereich Dokumente entweder
die Optionsschaltfliche Ordner, der das Programm ent-
hilt oder Ordner ,,Dokumente” anklicken. Schliefsen Sie
anschlieflend die Dialogbox Allgemeine Einstellungen,
und starten Sie QuarkXPress neu.

Wenn Sie die Standardeinstellung fiir die Dateiliste dndern,
konnen beim Aufrufen von Dokumenten tiber die Dateiliste
oder den Befehl Ablage -~ Offnen (Mac OS) bzw. Datei
Offnen (Windows) Dokumentduplikate auftreten. Dieses
Problem ldsst sich beheben, indem Sie die Datei ,,Dejavu.prf”
l6schen (Systemordner > Preferences unter Mac OS bzw.
Ordner ,,XTension” innerhalb des QuarkXPress oder Quark
XPress Passport Anwendungsordners unter Windows).

Seite 12 “www | inhait ][>
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Zusatzliche Informationen zur Guide Manager

QuarkXTensions Software

e Wenn Sie in eines der Felder im Register Hilfslinien hinzufii-
gen der Dialogbox Guide Manager einen ungiiltigen Wert ein-
geben und anschliefdend auf Hilfslinien hinzufiigen klicken,
kehrt QuarkXPress unter Umstanden ohne Warnung beziiglich
des ungiiltigen Werts zur Dialogbox Guide Manager zurtick.

e Wenn Sie auf Hilfslinien entfernen und anschlieflend auf
Abbrechen klicken und im Popup-Menti Wo die Option
Alle Montageflachen gewdhlt ist (Hilfsmittel > Guide
Manager > Register Hilfslinien entfernen oder festset-
zen > Bereich Hilfslinien entfernen), werden manche
Hilfslinien entfernt. Dies tritt aber nur in doppelseitigen
Dokumenten mit mehr als vier Seiten auf.

Zusatzliche Informationen zur Scissors QuarkXTensions

Software

e Wenn Sie einen Rahmen mit indexiertem Text durchschnei-
den, werden alle darin enthaltenen indexierten Worter aus
der Palette Index entfernt.

¢ (Nur Windows) Wenn Sie ein vertikales Segment eines Bildrah-
mens mehrfach durchschneiden, werden die Linien zwischen
den Schnittpunkten unter Umstanden nicht linger angezeigt.
Sie kdnnen aber trotzdem ausgewdhlt werden. Dieses Problem
lafst sich umgehen, indem Sie den Rahmen geringfiigig dre-
hen, bevor Sie das Segment durchschneiden.

Zusatzliche Informationen zur Super Step and Repeat

QuarkXTensions Software

e (Nur QuarkXPress Passport mit Zusatzsprachen) Wenn Sie
Super Step and Repeat verwenden und eine der Zusatzspra-
chen als Programmsprache gewdhlt ist (Bearbeiten -~ Pro-
grammsprache), friert QuarkXPress Passport ein. Dieses
Problem ldf3t sich umgehen, indem Sie zuerst eine der Stan-
dardsprachen von QuarkXPress Passport und dann Objekt >
Super-Duplizieren wihlen.

Seite 13 Cwvww | “inbatt ]
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Quark kontaktieren

Wenn Sie einen Plan fiir technischen Service erworben haben,
wenden Sie sich an IThre Quark Niederlassung oder Ihren Quark
Distributor.

Eine Liste der Quark Niederlassungen und Quark Distributoren
finden Sie in der Datei mit Informationen zur technischen
Unterstiitzung auf der QuarkXPress CD-ROM.

Eine aktuelle Liste der Quark Niederlassungen und Quark
Distributoren finden Sie unter dem Link , Quark kontaktieren”
auf der Quark Website unterwww.quark.de.

Fiir Produktinformationen besuchen Sie die Quark Website
unter www.quark.de.

Fiir technische Unterstiitzung zu QuarkXPress per eMail
senden Sie eine Nachricht an vertrieb@quark.de oder
MacTech@quark.com bzw. WinTech@quark.com.

m Seite 14
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Rechtliche Hinweise

©1999 Quark Technology Partnership fiir den Inhalt und die
Darstellung dieses Materials. Alle Rechte vorbehalten.

©1986-1999 Quark Technology Partnership fiir die Technologie.
Alle Rechte vorbehalten.

Die Informationen in diesem Dokument diirfen ohne die vorhe-
rige schriftliche Zustimmung von Quark Technology Partnership
oder dessen Lizenznehmer Quark, Inc., weder auf Papier noch in
elektronischer Form modifiziert, verteilt oder verbreitet werden.

Warenzeichen

Quark, QuarkXPress, QuarkXPress Passport, XTensions und
QuarkXTensions sind Warenzeichen von Quark, Inc., und aller
betreffenden verbundenen Unternehmen, Reg. U.S. Pat. & Tm.
Off. und in vielen anderen Landern. Das Quark Logo, QuarkLink
und andere gelegentlich von Quark, Inc., eingefiihrte Warenzei-
chen sind Warenzeichen von Quark, Inc., und aller betreffenden
verbundenen Unternehmen.

Adobe und PSPrinter sind Warenzeichen von Adobe Systems
Incorporated.

Alle anderen Warenzeichen sind das Figentum der jeweiligen
Inhaber.
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This document contains information about changes and additions

to QuarkXPress™, QuarkXPress Passport™, and QuarkXTensions™
software since “A Guide to QuarkXPress 4.1” was completed.
“A Guide to QuarkXPress 4.1"” is available as a PDF file on the . Last-Minute Information
QuarkXPress 4.1 or QuarkXPress Passport 4.1 CD-ROM.

. Supplemental Languages for QuarkXPress Passport

. Contacting Quark

. Legal Notices
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Supplemental Languages for QuarkXPress Passport

Hyphenation is available for the QuarkXPress Passport supplemen-
tal languages, which include Czech, Finnish, Greek, Hungarian,
Polish, and Portuguese for Mac OS, and Finnish, Hungarian,
Polish, and Portuguese for Windows.

Supplemental languages are included on the QuarkXPress
Passport 4.1 Updater CD-ROM. They are also available on a
separate Supplemental Languages CD-ROM. For information
about obtaining a Supplemental Languages CD-ROM, contact
your nearest Quark™ Office or Quark Full Service Distributor
(see the “Contacting Quark” section of this document).

m Page 17
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Last-Minute Information

NOTE Additional fixes may have been included and other
problems may have been discovered after this document was
published. For the most current information about known
problems, visit the Technical Support area of the Quark Web
site at www.quark.com.

Additional information about QuarkXPress 4.1

* (QuarkXPress Passport for Mac OS only) The help files for
QuarkXPress Passport have been updated in version 4.1. To
update these files, open the “Passport Help Files” folder on
the QuarkXPress Passport Updater CD-ROM. Locate the help
tile for the language you want, and drag-copy it into the
QuarkXPress Passport application folder on your computer’s
hard drive. If an older help file is already installed for that
language, replace the old help file with the new one.

* (Mac OS only) In addition to the variety of QuarkXTensions
modules provided by Quark, the QuarkXPress CD-ROM
includes many third-party free and demo XTensions™ mod-
ules. If you install a large number of XTensions, you will likely
need to increase the memory allocation for QuarkXPress. To
do this in Mac OS 8.1 or earlier, highlight the QuarkXPress
application icon and choose File > Get Info or press 36 +I;
in Mac OS 8.5 or later, highlight the QuarkXPress application
icon and choose File > Get Info >~ Memory or press 36 +],
and choose Memory from the Show pop-up menu. Next,
increase the amount in the Preferred Size field and close the
Info dialog box.

(Windows NT 3.51 only) Various display problems can occur
when running QuarkXPress 4.1 with Windows NT 3.51.

(Mac OS 9 only) If a user defined as a Limited User (6 -
Control Panels — Multiple Users) has access to a previously
installed copy of QuarkXPress 4.x and attempts to launch it
while non-4.0 native QuarkXTensions software is installed,
the non-native QuarkXTensions software fails to load, an
error message displays, and the QuarkXPress tools are dis-
abled. To use QuarkXPress in a Limited User account, rein-
stall QuarkXPress to the Limited User’s desktop or user folder.
Once QuarkXPress has been reinstalled using the Limited
User’s logon, it will launch correctly with non-4.0 native
QuarkXTensions software.

Additional information about the PDF Filter
QuarkXTensions software

In the “PDF Filter 1.3” section of “A Guide to QuarkXPress 4.1,”
the last two paragraphs of step 6 in “Setting preferences for
printing the PDF file” are erroneous. Please disregard these
two paragraphs.

Data in the More Information area of the Usage dialog box
Pictures tab (Utilities menu) may display incorrectly when
the PDF Filter is loaded.

The PDF Filter cannot import PDF files that contain embed-
ded CID 2-byte (Japanese, Korean, or Chinese) fonts.
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e (Mac OS 8.5.1 only) There is an incompatibility among

Mac OS 8.5.1, TrueType fonts, and LaserWriter 8.2.2 or earlier
drivers, or Adobe® PSPrinter™ 8.3.1 drivers. When exporting

a PDF file containing TrueType fonts under Mac OS 8.5.1
using one of these drivers, the computer can crash.

Additional information about QuarkLink QuarkXTensions
software
e There is a limit to the length of an e-mail you can send using

the QuarkLink™ software. The limit is 32K (32,766 characters).

If you reach that limit, you will not be able to enter more
text in the E-mail dialog box. If you attempt to paste text
that would exceed the limit into the E-mail dialog box,
QuarkLink will paste as many characters as it can until it
reaches the text limit.

Additional information about Custom Bleeds

QuarkXTensions software

e In a facing-page document, settings entered in the Inside
and Outside fields (File > Print > Bleed tab) do not pro-
duce the correct inside and outside bleeds when Spreads is
checked in the Print dialog box Document tab.

Additional information about DejaVu QuarkXTensions

software

e (Mac OS 8.x only) To enable a default path for File menu
commands, you must quit QuarkXPress and then choose
Control Panels -~ General Controls from the Apple (®)
menu, and click the radio button for either Folder that is
set by the application or Documents folder in the Docu-
ments area. Then click the close box of the General Con-
trols dialog box and relaunch QuarkXPress.

e When you change the default File List setting, you may see
duplicates of recently opened documents when you access
them using either File List or File > Open. As a workaround,
delete the “Dejavu.prf” file located in System Folder - Pref-
erences on Mac OS, or in the “XTension” folder within your
QuarkXPress or QuarkXPress Passport application folder on
Windows.

Additional information about Guide Manager

QuarkXTensions software

e [f you enter invalid information into one of the fields in the
Add Guides tab of the Guide Manager dialog box and then
click Add Guides, QuarkXPress may return to the Guide
Manager dialog box without displaying an error message
indicating that the information you entered is invalid.
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¢ If you click Remove Guides and then click Cancel when All
Spreads is chosen in the Where pop-up menu (Utilities >
Guide Manager >~ Remove or Lock Guides tab >~ Remove
Guides area), some guides will be removed. This occurs only
in facing-page documents that have more than four pages.

Additional information about Scissors QuarkXTensions

software

e If you cut a box containing indexed text, all indexed words
in that box will be removed from the Index palette.

e (Windows only) If you make multiple cuts to a vertical seg-
ment of a picture box, the lines between the cuts may no
longer display, but you can still select them. A workaround is
to rotate the box a small amount before cutting the segment.

Additional information about Super Step and Repeat

QuarkXTensions software

* (QuarkXPress Passport Supplemental Languages only) Using
Super Step and Repeat while the program language is set to
a supplemental language (Edit > Program Language) will
cause QuarkXPress Passport to freeze. As a workaround, change
the program language to a standard QuarkXPress Passport
language before choosing Item > Super Step and Repeat.
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Contacting Quark

In the Americas:

If you are under a technical support plan, or wish to purchase a
technical support plan, contact Quark Technical Support at
303.894.8899 between the hours of 7:00 a.m. and 6:00 p.m.
Mountain Time. For additional information on technical support,
see the technical support file on your QuarkXPress CD-ROM.

For e-mail support of QuarkXPress, send a message to
MacTech@quark.com or WinTech@quark.com. For product
information and technical support resources, visit the Quark
Web site at www.quark.com.

Outside the Americas:
If you are under a technical support plan, contact your local
Quark Office or Quark Full Service Distributor.

For a list of Quark Offices and Quark Full Service Distributors,
see the technical support file on your QuarkXPress CD-ROM.

For an up-to-date list of Quark offices and Quark Full Service
Distributors, click the “Contact Quark” link on the Quark Web
site at www.quark.co.uk.

For product information, visit the Quark Web site at
www.quark.co.uk.

For e-mail support of QuarkXPress, send a message to
technical@quark.co.uk, MacTech@quark.com, or
WinTech@quark.com.
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Legal Notices

©1999 Quark Technology Partnership as to the content and
arrangement of this material. All rights reserved.

©1986-1999 Quark Technology Partnership as to the technology.
All rights reserved.

The information in this document may not be modified, dis-
tributed, or disseminated in paper or electronic form without
prior written consent of Quark Technology Partnership or its
licensee, Quark, Inc.

Trademark information

Quark, QuarkXPress, QuarkXPress Passport, XTensions, and
QuarkXTensions are trademarks of Quark, Inc. and all applica-
ble affiliated companies, Reg. U.S. Pat. & Tm. Off. and in many
other countries. The Quark logo, QuarkLink, and other trade-
marks Quark, Inc. may adopt from time to time, are trademarks
of Quark, Inc. and all applicable affiliated companies.

Adobe and PSPrinter are trademarks of Adobe Systems
Incorporated.

All other trademarks are the properties of their respective owners.
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Este documento contiene informacion acerca de los cambios y
adiciones en el software QuarkXPress™, QuarkXPress Passport™y
QuarkXTensions™ que se produjeron tras la terminacion de la
“Guia de QuarkXPress 4.1”. Esta guia esta disponible en for-
mato PDF en el CD-ROM de QuarkXPress 4.1 y QuarkXPress
Passport 4.1.

. Idiomas de suplemento para QuarkXPress Passport

. Informacion de ultima hora
. Contactos con Quark

. Avisos legales
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Idiomas de suplemento para QuarkXPress Passport

La particion de palabras esta disponible para los idiomas del

suplemento de QuarkXPress Passport, que incluyen el checo,
finlandés, griego, htingaro, polaco y portugués para Mac OS, y
el finlandés, htingaro, polaco y portugués para Windows.

Los idiomas del suplemento se incluyen en el CD-ROM del pro-
grama de actualizacion a QuarkXPress Passport 4.1. También se
distribuyen por separado en un disco CD-ROM de idiomas de
suplemento. Si desea informacion acerca de coOmo obtener un
CD-ROM de idiomas del suplemento, pongase en contacto con
la oficina de Quark™ o el distribuidor “Full Service” mas cercano
(consulte la seccion “Contactos con Quark” de este mismo
documento).
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Informacion de ultima hora

NOTA Es posible que se hayan incluido correcciones adiciona-
les o detectado otros problemas después de la publicacion de
este documento. Para obtener la informacion mas actualizada
acerca de los problemas identificados (Known Problems), con-
sulte el area “Technical Support” del sitio Web de Quark en
www.quark.com o www.quark.co.uk.

Informacion adicional acerca de QuarkXPress 4.1

e (QuarkXPress Passport para Mac OS solamente) Los archivos
de ayuda para QuarkXPress Passport han sido actualizados a
la version 4.1. Para actualizar estos archivos, abra la carpeta
“Passport Help Files” en el disco CD-ROM QuarkXPress
Passport Updater. Localice el archivo de ayuda que desee
utilizar, arrastrelo para copiarlo en la carpeta de la aplica-
cion de QuarkXPress Passport en el disco duro de su ordena-
dor. Si el archivo de ayuda para ese idioma ya esta instalado,
sustitityalo con el nuevo.

e (Mac OS solamente) Ademas de los diversos moédulos de
QuarkXTensions ofrecidos por Quark, el CD-ROM de Quark
XPress incluye muchos modulos de XTensions™ gratuitos y de
demostracion que vienen de terceros proveedores. Si instala
varios modulos de XTensions, lo mas probable es que tenga
que aumentar la asignacion de memoria para QuarkXPress.

Para hacer esto en Mac OS 8.1 o versiones anteriores, resalte
el icono de la aplicacion QuarkXPress y elija Archivo -
Obtener informacion o pulse 3 +I; en Mac OS 8.5 o versio-
nes posteriores, resalte el icono de la aplicacion QuarkXPress
y elija Archivo - Obtener informacion -~ Memoria o
pulse 3 +1, y elija Memoria del ment emergente Mostrar.
Seguidamente, aumente la cantidad en el campo Tamaifio
preferido y cierre el cuadro de didlogo de informacion.

(Mac OS 9 solamente) Si un usuario definido como un usua-
rio limitado (en la opcion para multiples usuarios de los
paneles de control en el ment &) tiene acceso a una copia de
QuarkXPress 4.x instalada con anterioridad e intenta iniciarla
mientras moéduls de software de QuarkXTensions que no
sean para la version 4.0 se encuentren instaladaos, dichos
modulos no se cargaran, aparecera un mensaje de error y las
herramientas de QuarkXPress quedaran inhabilitadas. Para
utilizar una cuenta de usuario limitado, vuelva a instalar Quark
XPress en el escritorio o carpeta de usuario para el usuario
limitado. Una vez que QuarkXPress se haya vuelto a instalar
mediante el inicio de sesién de usuario limitado, arrancara
correctamente con software de QuarkXTensions que no sea
de la version 4.0.
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e (Windows NT 3.51 solamente) Es posible que se produzcan
varios problemas con la visualizacion en pantalla si se eje-
cuta QuarkXPress 4.1 con Windows NT 3.51.

Informacion adicional acerca del software de QuarkXTensions

PDF Filter

e En la seccién “PDF Filter 1.3” de la “Guia de QuarkXPress 4.1”,
los dos ultimos parrafos del paso 6 en el procedimiento “Esta-
blecimiento de preferencias para la impresion de archivos PDF”
son incorrectos. No los tenga en cuenta.

e Cuando esta cargado PDF Filter, puede que no se muestren
correctamente los datos en el area Mas informacion del
cuadro de didlogo Utilizacion en la ficha Imagenes (ment
Utilidades).

e PDF Filter no puede importar archivos PDF que contengan
fuentes CID de dos bytes (japonés, coreano o chino).

e (Mac OS 8.5.1 solamente) Existe una incompatibilidad
entre Mac OS 8.5.1, fuentes TrueType y controladores para
LaserWriter 8.2.2 o anteriores, o controladores para Adobe®
PSPrinter™ 8.3.1. Si se utiliza uno de estos controladores y
Mac OS 8.5.1, el ordenador puede quedar bloqueado al
exportar un archivo PDF que contenga fuentes TrueType.

Informacion adicional acerca del software de QuarkXTensions

QuarkLink

e Existe un tamafilo maximo para correo electronico que se
puede enviar utilizando el software QuarkLink™. El limite es
32 K (32.766 caracteres). Si alcanza este limite, no podra

introducir mas texto en el cuadro de dialogo Correo electro-
nico. Si intenta pegar en este cuadro de didlogo una cantidad
de texto que supera el limite, QuarkLink pegara el maximo de
caracteres que pueda, cortando todo el texto que sobrepase el
limite mencionado.

Informacion adicional acerca del software de QuarkXTensions

Custom Bleeds

¢ En un documento de paginas enfrentadas, los ajustes intro-
ducidos en los campos Interior y Exterior (Archivo -
Imprimir - ficha Sangrar) no producen las sangrias interior
y exterior correctas cuando se halla seleccionada la opcion
Planchas extendidas en el cuadro de dialogo Imprimir de
la ficha Documento.

Informacion adicional acerca del software de QuarkXTensions

DejaVu

e (Mac OS 8.x solamente) Con objeto de habilitar una via de
acceso por omision para los comandos del ment Archivo,
debera salir de QuarkXPress, elegir Paneles de Control >
General del ment Apple (®) y hacer clic en el bot6n de
radio correspondiente a Carpeta configurada por la aplica-
cion o a Carpeta Documentos, en el area Documentos.
Luego haga clic en el cuadro de cierre del cuadro de dialogo
General y vuelva a iniciar QuarkXPress.

e Si cambia el ajuste por omision de Lista de archivos, es posi-
ble que vea duplicados de los documentos abiertos reciente-
mente al abrirlos mediante Lista de archivos o Archivo >
Abrir. Como solucién, suprima el archivo “Dejavu.prf”
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situado en Carpeta del Sistema > Preferencias en Mac OS,
o en la carpeta “XTension” dentro de la carpeta de la aplica-
cion QuarkXPress o QuarkXPress Passport en Windows.

posible seleccionarlas. Una solucion consiste en girar ligera-
mente el cuadro antes de cortar el segmento.

Informacion adicional acerca del software de QuarkXTensions

Super Step and Repeat

¢ (Idiomas del suplemento de QuarkXPress Passport solamente)
Si se utiliza Super Step and Repeat cuando el programa esta

Informacion adicional acerca del software de QuarkXTensions
Guide Manager
¢ Siintroduce informacion no valida en uno de los campos en

la ficha Anadir guias del cuadro de didlogo Guide Manager
y hace clic en Afadir guias, QuarkXPress podria volver al cua-
dro de didlogo Guide Manager sin mostrar un mensaje de
error que indica que la informacion introducida no es valida.

establecido en un idioma del suplemento (Edicion - Idioma
del programa), QuarkXPress Passport quedara bloqueado.
Como solucion, cambie el idioma del programa a uno estan-
dar de QuarkXPress Passport antes de elegir Elemento -

e Sila opcion Todas las planchas extendidas esta seleccio- Superduplicacion con parametros.

nada en el ment emergente Localizacion (Utilidades >
Guide Manager - pestafia Eliminar o bloquear guias >
area Eliminar guias) y hace clic en Eliminar guias y des-
pués en Cancelar, se eliminaran algunas de las guias. Esto
sOlo ocurre en documentos de paginas enfrentadas que tie-
nen mas de cuatro paginas.

Informacion adicional acerca del software de QuarkXTensions

Scissors

e Si corta un cuadro que contiene texto indizado, todas las
palabras indizadas en el cuadro se eliminaran de la paleta
Indice.

e (Windows solamente) Si hace varios cortes en un segmento
vertical de un cuadro de imagen, es posible que dejen de
visualizarse las lineas entre los cortes, aunque sigue siendo
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Contactos con Quark Con objeto de obtener asistencia para QuarkXPress por correo

electronico, envie un mensaje a technical@quark.co.uk o

En las Americas MacTech@quark.com o WinTech@quark.com.

Si participa en un plan de asistencia técnica o desea adquirirlo,
poéngase en contacto con el servicio de asistencia técnica de
Quark llamando al teléfono 303.894.8899 entre las 7.00 y las
18.00 h (huso horario de la Montafia). Si desea informacién
adicional sobre la asistencia técnica, consulte el archivo de asis-
tencia técnica de su disco CD-ROM de QuarkXPress.

Con obijeto de recibir asistencia para QuarkXPress por correo
electronico, envie un mensaje a MacTech@quark.com o
WinTech@quark.com. Si necesita informacion sobre el pro-
ducto o recursos de asistencia técnica visite el sitio Web de
Quark en: www.quark.com.

Fuera de las Américas
Si participa en un plan de asistencia técnica, péngase en contacto
con su oficina o distribuidor “Full Service” de Quark.

Para obtener una lista de oficinas y distribuidores “Full Service”
de Quark, consulte el archivo de asistencia técnica incluido en
su disco CD-ROM de Quark.

Si desea obtener una lista actualizada de las oficinas y distribui-
dores “Full Service” de Quark, haga clic en el vinculo “Contact
Quark” del sitio Web de Quark en: www.quark.co.uk.

Para obtener informacion acerca del producto, visite la sede
Web de Quark en www.quark.co.uk.
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Avisos legales

© Quark Technology Partnership, 1999, sobre el contenido y la
organizacion de este material. Reservados todos los derechos.

© Quark Technology Partnership, 1986-1999, sobre la tecnologia.
Reservados todos los derechos.

La informacion contenida en este documento no se puede modi-
ficar, distribuir o difundir en papel o en formato electronico sin
el consentimiento previo y por escrito de Quark Technology
Partnership o su concesionario Quark, Inc.

Informacion sobre marcas

Quark, QuarkXPress, QuarkXPress Passport, XTensions y Quark
XTensions son marcas comerciales de Quark, Inc. y de todas las
empresas afiliadas correspondientes, Reg. U.S. Pat. & Tm. Off. y
en otros muchos paises. El logotipo de Quark, QuarkLink, y
otras marcas comerciales que Quark, Inc. pueda adoptar en el
futuro, son marcas comerciales de Quark, Inc., y de todas las
empresas afiliadas correspondientes.

Adobe y PSPrinter son marcas comerciales de Adobe Systems
Incorporated.

Las restantes marcas comerciales son propiedad de sus respecti-
vos titulares de derecho.
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Ce document contient des informations concernant les modifica-
tions et ajouts apportés a QuarkXPress™, QuarkXPress Passport™
et aux logiciels QuarkXTensions™ depuis la rédaction du Guide
QuarkXPress 4.1. Ce guide est disponible sous forme de fichier PDF
sur le CD-ROM QuarkXPress 4.1 ou QuarkXPress Passport 4.1.

. Langues supplémentaires QuarkXPress Passport
. Informations de derniére minute
. Comment contacter Quark

. Notices légales
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Langues supplémentaires QuarkXPress Passport

La fonction de césure est disponible pour les langues supplé-
mentaires QuarkXPress Passport, qui comprennent le tcheque,
le finnois, le grec, le hongrois, le polonais et le portugais pour
Mac OS, et le finnois, le hongrois, le polonais et le portugais
pour Windows.

Les langues supplémentaires sont disponibles sur le CD-ROM
du Programme de mise a niveau de QuarkXPress Passport 4.1.
Elles sont également disponibles sur le CD-ROM propre a ces
langues. Pour savoir comment obtenir le CD-ROM des langues
supplémentaires, contactez le bureau Quark™ le plus proche ou
un distributeur Full Service des produits Quark (reportez-vous
a la section « Comment contacter Quark » de ce document).
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Informations de derniére minute

REMARQUE Des corrections supplémentaires ont pu étre
apportées et d’autres problemes résolus depuis la rédaction du pré-
sent document. Pour obtenir des informations plus actuelles sur les
problemes connus (Known Problems), visitez la page Assistance du
site Internet de Quark, www.quark.fr ou www.quark.com.

Informations complémentaires concernant QuarkXPress 4.1

* (QuarkXPress Passport pour Mac OS uniquement) Les fichiers
d’aide de QuarkXPress Passport ont été actualisés pour la ver-
sion 4.1. Pour les mettre a jour, ouvrez le dossier « Passport
Help Files » du CD-ROM du Programme de mise a niveau
QuarkXPress Passport. Recherchez le fichier d’aide correspon-
dant a la langue utilisée, puis faites-le glisser dans le dossier
d’application QuarkXPress Passport sur votre disque dur. Si un
fichier ancien est déja installé pour la langue choisie, rempla-
cez-le par le nouveau.

* (Mac OS uniquement) En plus des nombreux modules Quark
XTensions fournis par Quark, le CD-ROM QuarkXPress com-
porte plusieurs logiciels d’XTensions™ tiers gratuits ou de
démonstration. Si vous décidez d’installer un grand nombre
d’XTensions, il vous faudra sans doute augmenter la mémoire
allouée a QuarkXPress. Pour cela, sous Mac OS 8.1 ou les ver-
sions antérieures, mettez en surbrillance 'icone de QuarkXPress
ou de QuarkXPress Passport et choisissez Fichier - Lire les
infos ou appuyez sur la touche Pomme + I ; sous Mac OS 8.5
ou les versions ultérieures, mettez en surbrillance 1'icone
de QuarkXPress ou QuarkXPress Passport et choisissez

Fichier > Lire les infos ~ Mémoire ou appuyez sur la
touche Pomme + I et sélectionnez Mémoire dans le menu
déroulant Afficher. Augmentez la valeur du champ Mémoire
souhaitée et fermez la zone de dialogue Informations.

(Mac OS 9 uniquement) Lorsqu’un utilisateur défini comme
« utilisateur a acces limité » ( menu Pomme - Tableaux de
bord - commande pour plusieurs utilisateurs) a acces a
une version précédente de QuarkXPress 4.x et tente de la
lancer alors que des logiciels QuarkXTensions non natifs
sont installés, ces derniers ne se chargent pas, un message d’er-
reur s’affiche et les outils QuarkXPress sont désactivés. Pour
utiliser QuarkXPress avec un compte « d’utilisateur a acces
limité », réinstallez QuarkXPress dans le bureau « d’utilisateur a
acces limité » ou le dossier utilisateur. QuarkXPress a été réins-
tallé a I’aide de la connexion « utilisateur a acces limité », il
sera lancé correctement ainsi que les logiciels QuarkXTensions
non natifs.

(Windows NT 3.51 uniquement) Différents problemes d’affi-
chage se produisent lors de ’exécution de QuarkXPress 4.1
sous Windows NT 3.51.

Informations complémentaires concernant le logiciel
QuarkXTensions PDF Filter

Dans la section intitulée « PDF Filter 1.3 » du Guide Quark
XPress 4.1, les deux derniers paragraphes de 1’étape 6 de la
rubrique « Définition des préférences pour l'impression de
fichiers PDF » sont erronés. Veuillez ne pas en tenir compte.
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e Les données de la zone Info. supplémentaires de la rubrique Informations complémentaires concernant le logiciel
Images de la boite de dialogue Usage (menu Utilitaires) peu- QuarkXTensions Custom Bleeds
vent s’afficher de maniere incorrecte lorsque PDF Filter est e Dans un document contenant des pages en vis-a-vis, les
chargé. parametres entrés dans les champs Intérieur et Extérieur

(Fichier >~ Imprimer > onglet Fond perdu) ne produisent
pas de fonds perdus intérieurs et extérieurs corrects lorsque
la case Planches est cochée dans la rubrique Document de
la boite de dialogue Imprimer.

e PDF Filter ne peut pas importer de fichiers PDF contenant
des polices imbriquées CID a 2 octets (japonais, coréen ou
chinois).

e (Mac OS 8.5.1 uniquement) Il existe une incompatibilité

entre Mac OS 8.5.1, les polices TrueType et LaserWriter 8.2.2 Informations complémentaires concernant le logiciel

ou pilotes antérieurs ou les pilotes Adobe® PSPrinter™ 8.3.1. QuarkXTensions DejaVu

Lors de I'exportation d’un fichier PDF contenant des polices * (Mac OS 8.x uniquement) Pour activer un chemin par défaut

TrueType sous Mac OS 8.5.1 utilisant 'un de ces pilotes, pour les commandes du menu Fichier, vous devez quitter

votre ordinateur risque de tomber en panne. QuarkXPress, puis choisir Tableaux de bord - Général du

menu Pomme (@), et cliquer sur la case d’option pour le

Informations complémentaires concernant le logiciel dossier de l'application ou le dossier « Documents » de la
QuarkXTensions QuarkLink zone Documents. Cliquez ensuite sur la case de fermeture de
e Lalongueur des messages e-mail envoyés a 1'aide du logiciel la zone de dialogue Général et relancez QuarkXPress.

QuarkLink™ ne peuvent pas dépasser 32 k (32 766 carac-
teres). Une fois cette limite atteinte, vous ne pourrez plus
entrer de texte dans la boite de dialogue E-mail. Si vous
essayez de coller dans cette derniere un texte dépassant la
limite, QuarkLink collera autant de caracteres que possible
jusqu’a atteindre cette limite.

e Lorsque vous modifiez les parametres de la Liste de fichiers
par défaut, il se peut que vous affichiez des doubles des der-
niers documents ouverts lorsque vous y accédez par la
Liste de fichiers ou Fichier >~ Ouvrir. Pour contourner
le probleme, supprimez le fichier « Dejavu.prf » situé dans
Dossier Systeme - Préférences sous Mac OS ou dans
le dossier « XTension » de votre dossier d’application
QuarkXPress ou QuarkXPress Passport sous Windows.
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Informations complémentaires concernant le logiciel
QuarkXTensions Guide Manager
e Sivous entrez des informations erronées dans un des

Informations complémentaires concernant le logiciel
QuarkXTensions Super Step and Repeat
¢ (Langues supplémentaires QuarkXPress Passport unique-

champs de la rubrique Ajouter des reperes de la boite de
dialogue Guide Manager, puis cliquez sur Ajouter des
reperes, QuarkXPress peut retourner dans la boite de dia-
logue Guide Manager sans afficher de message d’erreur
indiquant que l'information entrée est erronée.

e Sivous cliquez sur Supprimer des repeéres, puis cliquez sur

ment) L'utilisation de Super Step and Repeat lorsque la
langue du programme est une langue supplémentaire (Edi-
tion > Langue du programme) entrainera un blocage de
QuarkXPress Passport. La solution de contournement
consiste a utiliser une langue QuarkXPress Passport stan-
dard avant de choisir Bloc > Super Step and Repeat.

Annuler lorsque Toutes les planches est sélectionné dans
le menu déroulant Emplacement (Utilitaires - Guide
Manager > onglet Supprimer ou bloquer des reperes >
zone Supprimer des reperes), certains reperes seront sup-
primés. Cela se produit uniquement pour des documents
de plus de quatre pages comportant des pages en vis-a-vis.

Informations complémentaires concernant le logiciel

QuarkXTensions Scissors

e Si vous coupez un bloc contenant du texte index¢, tous
les mots indexés de ce bloc seront supprimés de la palette
des Index.

¢ (Windows uniquement) Si vous effectuez plusieurs coupures
sur un segment vertical d'un bloc d’image, les lignes entre les
coupures ne s’afficheront plus, mais vous pourrez toujours les
sélectionner. La solution de contournement consiste a effec-
tuer une légere rotation du bloc avant de couper le segment.
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Comment contacter Quark Pour le support par e-mail de QuarkXPress, envoyez un

message a supporttech@quark.fr ou MacTech@quark.com

Sur le continent américain .
ou WinTech@quark.com.

Si vous disposez d'un plan de support technique ou souhaitez
en acquérir un, contactez le support technique de Quark au
303.894.8899 entre 7 heures et 18 heures, heure des montagnes
Rocheuses. Pour plus d’informations concernant le support tech-
nique, consultez le fichier correspondant sur votre CD-ROM
QuarkXPress.

Vous pouvez également soumettre vos questions par courrier
électronique a MacTech@quark.com ou WinTech@quark.com.

Pour des informations concernant les produits et le support tech-
nique, visitez le site Web de Quark a I'adresse www.quark.fr.

Hors du continent américain

Si vous disposez d'un plan de support technique, contactez
le bureau Quark le plus proche ou un distributeur Full Service
de Quark.

Pour consulter la liste des bureaux et des distributeurs Full
Service de Quark, reportez-vous au fichier du support technique
sur votre CD-ROM QuarkXPress.

Pour obtenir une liste a jour des bureaux et distributeurs Full
Service de Quark, cliquez sur le lien « Contacter Quark » sur le
site Web de Quark a 'adresse www.quark.fr.

Pour des informations concernant les produits, visitez le site
Web de Quark a I’adresse www.quark.fr.
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Notices légales

©1999 Quark Technology Partnership pour le contenu et la
présentation de ce document. Tous droits réservés.

©1986-1999 Quark Technology Partnership pour la technologie.
Tous droits réservés.

Les informations contenues dans ce document ne peuvent pas
étre modifiées, distribuées ou diffusées sous forme écrite ou élec-
tronique sans 1’accord écrit préalable de Quark Technology
Partnership ou du détenteur de licence, Quark, Inc.

Informations relatives aux marques

Quark, QuarkXPress, QuarkXPress Passport, XTensions et
QuarkXTensions sont des marques de Quark, Inc. et de toutes
les sociétés affiliées concernées, Reg. U.S. Pat. & Tm. Off., et
dans de nombreux pays. Le logo Quark, QuarkLink et les
autres marques que Quark, Inc. utilise de temps en temps
sont des marques de Quark, Inc., et de toutes les sociétés
affiliées concernées.

Adobe et PSPrinter sont des marques de Adobe Systems
Incorporated.

Toutes les autres marques sont détenues par leurs propriétaires
respectifs.
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Questo documento contiene informazioni relative ai cambia-
menti e alle aggiunte apportati a QuarkXPress™, QuarkXPress
Passport™ e QuarkXTensions™ dal momento della pubblicazione
della “Guida a QuarkXPress 4.1”. La “Guida a QuarkXPress 4.1”
¢ disponibile in formato PDF nel CD-ROM QuarkXPress 4.1 o
QuarkXPress Passport 4.1.

. Lingue supplementari per QuarkXPress Passport
. Informazioni dell’ultimo minuto

. Come contattare Quark

. Note legali
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Lingue supplementari per QuarkXPress Passport

Un programma di sillabazione ¢ ora disponibile per le lingue
supplementari di QuarkXPress Passport che includono ceco,
finlandese, greco, ungherese, polacco e portoghese per Mac OS
e finlandese, ungherese, polacco e portoghese per Windows.

Le lingue supplementari sono incluse nel CD-ROM di aggiorna-
mento di QuarkXPress Passport 4.1, ma sono anche disponibili
separatamente sul CD-ROM Lingue Supplementari (“Supplemen-
tal Languages”). Per informazioni su come ottenere il CD-ROM
Lingue Supplementari siete pregati di contattate il piu vicino
Ufficio Quark™ o distributore autorizzato Full Service di Quark
(vedi la sezione “Come contattare Quark” in questo documento).
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Informazioni dell’'ultimo minuto

NOTA Alcuni problemi potrebbero essere stati risolti ed altri
scoperti successivamente alla pubblicazione di questo docu-
mento. Per ricevere informazioni piu aggiornate sui “problemi
conosciuti” (Known Problems), siete pregati di visitare l’area di
assistenza tecnica del sito Web di Quark all’indirizzo
www.quark.co.uk.

Informazioni aggiornate su QuarkXPress 4.1

* (Solo per QuarkXPress Passport per Mac OS) I file di Aiuto per
QuarkXPress Passport sono stati aggiornati alla versione 4.1.
Per aggiornare questi file, aprite la cartella “Passport Help Files’
situata sul CD-ROM di aggiornamento di QuarkXPress Passport.
Selezionate il file di Aiuto per la lingua desiderata, quindi
copiatelo nella cartella dell’applicazione QuarkXPress Passport
situata sul disco fisso del vostro computer. Nel caso in cui sia
gia stato installato un file di Aiuto per la lingua selezionata,
sostituite il vecchio file con la nuova versione.

’

* (Solo per Mac OS) Oltre alla varieta di moduli QuarkXTensions
forniti da Quark, il CD-ROM QuarkXPress contiene anche le
versioni dimostrative gratuite di molti moduli XTensions™
creati da terzi. Se installate un numero elevato di XTensions,
dovrete probabilmente aumentare ’allocazione di memoria
assegnata a QuarkXPress. Per fare cio e, se usate Mac OS 8.1 o
versioni precedenti, selezionate 1'icona di QuarkXPress e sce-
gliete File > Informazioni o premete 36 +1. Se usate Mac OS
8.5 o versioni successive, selezionate I'icona di QuarkXPress e

scegliete File > Informazioni ~ Memoria o premete 36+I, e
scegliete Memoria dal menu a discesa Mostra. Quindi, aumen-
tate la quantita indicata nel campo Dimensione Preferita e
chiudete la finestra di dialogo Info su.

(Solo per Mac OS 9) Se un utente ¢ stato definito come “utente
limitato” (tramite il pannello di controllo) e utilizza una copia
di QuarkXPress 4.x precedentemente installata e decide di
lanciarla mentre sono installate QuarkXTensions non native
di 4.0, queste QuarkXTensions non verranno caricate, verra
visualizzato un messaggio di avvertimento e gli strumenti

di QuarkXPress verranno disabilitati. Per poter utilizzare
QuarkXPress come “utente limitato”, dovete reinstallarlo
sulla scrivania di tale utente o collocarlo nella sua cartella.
Una volta che QuarkXPress e stato reinstallato utilizzando
I’accesso dell’utente, il software QuarkXTensions non nativo
di 4.0 verra lanciato correttamente.

(Solo per Windows NT 3.51) Si potrebbero verificare vari
problemi di visualizzazione quando si esegue QuarkXPress
4.1 con Windows NT 3.51.

Informazioni aggiornate sul software QuarkXTensions
PDF Filter

Nella sezione “Il filtro PDF 1.3” della “Guida a QuarkXPress
4.1,” gli ultimi due paragrafi della fase 6 di “Impostazione

delle preferenze per la stampa di un file PDF” contengono

informazioni errate. Siete pregati di ignorare le informazioni
contenute nei suddetti paragrafi.
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I dati contenuti nell’area Altre informazioni nella scheda
Immagini della finestra di dialogo Utilizzo (menu Utilita)
potrebbero essere visualizzati in modo incorretto quando
viene caricato il filtro PDF.

Il filtro PDF non ¢ in grado di importare i file PDF che con-
tengono le font CID a 2 byte (giapponese, coreano e cinese).

(Solo per Mac OS 8.5.1) Esiste un’incompatibilita fra
Mac OS 8.5.1, le font TrueType e LaserWriter 8.2.2 o i driver
precedenti, o i driver Adobe® PSPrinter™ 8.3.1. Quando

si esporta un file PDF contenente le font TrueType in
Mac OS 8.5.1 usando uno dei suddetti driver, il computer
potrebbe bloccarsi.

Informazioni aggiornate sul software QuarkXTensions
QuarkLink

¢ Esiste un limite alla lunghezza delle e-mail che potete spedire

usando il software QuarkLink™. Questo limite ¢ pari a 32K
(32.766 caratteri). Una volta raggiunto tale limite, non potrete
inserire nessun altro testo nella finestra di dialogo E-mail. Se
cercate di incollare nella finestra di dialogo E-mail una qua-
lunque altra porzione di testo superiore al suddetto limite,
QuarkLink incollera tutti i caratteri che potra incollare fino
a raggiungere il limite imposto al testo.

Informazioni aggiornate relative al software QuarkXTensions
Custom Bleeds

In un documento a pagine affiancate, le impostazioni inserite
nei campi Interno e Esterno (File/Archivio > Stampa -
scheda Al vivo) non producono i corretti risultati “al vivo”
interni ed esterni quando si seleziona la casella Documenti
distesi nella scheda Documento della finestra di dialogo
Stampa.

Informazioni aggiornate relative al software
QuarkXTensions DejaVu
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(Solo per Mac OS 8.x) Per attivare il percorso di default per i
comandi del menu Archivio, dovete uscire da QuarkXPress e
successivamente selezionare Pannello di controllo >~ Con-
trolli generali dal menu “Apple” (®). Fate quindi clic sul pul-
sante di opzione della Cartella impostata dall’applicazione
o su quello della Cartella documenti nell’area Documenti.
Quindi, fate clic sulla casella di chiusura della finestra di dia-
logo Controlli generali e riavviate QuarkXPress.

Quando cambiate I'impostazione di default dell’Elenco
documenti, potreste vedere i duplicati di documenti che
sono stati aperti di recente se ne avete ottenuto 1’accesso
usando Elenco documenti o Archivo > Apri. Per ovviare
a tale inconveniente, cancellate il file “Dejavu.prf” situato
nella Cartella di Sistema - Preferenze in Mac OS, o nella
cartella “XTension” contenuta nella cartella applicazione di
QuarkXPress o QuarkXPress Passport in Windows.
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Informazioni aggiornate relative al software QuarkXTensions Informazioni aggiornate relative al software QuarkXTensions
Guide Manager Super Step and Repeat
¢ Seinserite informazioni non valide in uno dei campi della ¢ (Solo per QuarkXPress Passport Lingue Supplementari) L'uso

scheda Aggiungi le guide della finestra di dialogo Guide
Manager e successivamente fate clic su Aggiungi le guide,
QuarkXPress potrebbe ritornare alla finestra di dialogo
Guide Manager senza visualizzare un messaggio di errore
che sta ad indicare che l'informazione da voi inserita non
era valida.

e Se fate clic su Elimina le guide e quindi su Annulla
quando Tutti i documenti distesi ¢ stato selezionato nel
menu a discesa Posizione (Utilita >~ Guide Manager
linguetta Elimina o proteggi guide - sezione Elimina
le guide), alcune guide saranno rimosse. Cio accade solo
nei documenti a pagine affiancate contenenti piu di quattro
pagine.

Informazioni aggiornate relative al software QuarkXTensions

Scissors

¢ Se tagliate una finestra contenente un testo indicizzato, tutte
le parole indicizzate contenute nella finestra saranno rimosse
dalla palette Indice.

¢ (Solo per Windows) Se effettuate tagli multipli su un segmento
verticale di una finestra immagine, le linee comprese fra i
tagli potrebbero non essere visualizzate, anche se la possi-
bilita di selezionarle resta invariata. Per ovviare a tale incon-
veniente, vi consigliamo di ruotare leggermente la finestra
immagine prima di tagliare il segmento.

di Super Step and Repeat quando la lingua del programma ¢
impostata come lingua supplementare (Comp./Modifica >
Lingua del programma) provochera un blocco nel funzio-
namento di QuarkXPress Passport. Per ovviare a tale incon-
veniente, cambiate la lingua del programma in una delle
lingue standard di QuarkXPress Passport prima di selezionare
Oggetti > Super duplica speciale.
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Come contattare Quark

Se disponete di un programma di supporto tecnico, contattate
il vostro ufficio locale Quark o un distributore Full Service auto-
rizzato Quark.

Per un elenco completo degli uffici Quark e dei distributori Full
Service autorizzati Quark, fate riferimento al file sul supporto
tecnico contenuto nel CD-ROM di QuarkXPress Passport.

Per un elenco aggiornato degli uffici Quark e dei distributori Full
Service autorizzati Quark, fate clic sul collegamento “Contact
Quark” al sito Web di Quark all'indirizzo www.quark.co.uk.

Per informazioni sul prodotto, visitate il sito Web di Quark
all’indirizzo www.quark.co.uk.

Per supporto tecnico di QuarkXPress tramite e-mail, inviate un
messaggio a technical @quark.co.uk o MacTech@quark.com
oppure a WinTech@quark.com.
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Note legali

©1999 Quark Technology Partnership per il contenuto e la
forma di questo documento. Tutti i diritti riservati.

©1986-1999 Quark Technology Partnership per la tecnologia.
Tutti i diritti riservati.

Le informazioni contenute in questo documento non possono
essere modificate, distribuite o divulgate, in forma scritta o
elettronica, senza il previo consenso scritto da parte di Quark
Technology Partnership o del suo licenziatario Quark, Inc.

Informazioni sui marchi di fabbrica

Quark, QuarkXPress, QuarkXPress Passport, XTensions ed
QuarkXTensions sono marchi commerciali di Quark, Inc. e di
tutte le relative societa affiliate, Reg. U.S. Pat. & Tm. Off. e in
molti altri paesi. Il logo Quark, QuarkLink e altri marchi com-
merciali che Quark, Inc. potrebbe adottare di volta in volta,
sono marchi commerciali di Quark, Inc. e di tutte le relative
societa affiliate.

Adobe e PSPrinter sono marchi commerciali di Adobe Systems
Incorporated.

Tutti gli altri marchi sono di proprieta dei rispettivi depositari.
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AR

I dit document staat informatie over wijzigingen n en

aanvullingen bij QuarkXPress™, QuarkXPress Passport™- en

QuarkXTensions™-software sinds “QuarkXPress 4.1 in vogel- . Extra talen voor QuarkXPress Passport
vlucht” van de pers rolde. “QuarkXPress 4.1 in vogelvlucht”
is beschikbaar als een PDF-bestand op de QuarkXPress 4.1- of
QuarkXPress Passport 4.1 CD-ROM. Bl contact opnemen met Quark

. Meest recente informatie

. Verantwoording
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Extra talen voor QuarkXPress Passport

Een afbreekwoordenboek is beschikbaar voor de extra talen in
QuarkXPress Passport, zoals Fins, Grieks, Hongaars, Pools,
Portugees en Tsjechisch voor Mac OS, en Fins, Hongaars, Pools
en Portugees voor Windows.

De extra talen staan op de QuarkXPress Passport 4.1 Updater
CD-ROM. U kunt ze ook vinden op een aparte Supplemental
Languages CD-ROM. Neem voor informatie over de manier
waarop u in het bezit kunt komen van een Supplemental Lan-
guages CD-ROM contact op met het dichtstbijzijnde Quark™-
kantoor of Quark Full Service Distributor (zie onder “Contact
opnemen met Quark” verderop in dit document).
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van QuarkXPress markeren, maar dan Kkiest u Archief -
Info >~ Geheugen of u drukt op 3 +I, waarna u in het
venstermenu Toon de optie Geheugen selecteert. Verhoog

Meest recente informatie

N.B.: Na het verschijnen van dit document zijn er waarschijn-
lijk nog problemen opgelost en een paar nieuwe problemen ont-

dekt. Voor de meest recente informatie over bekende problemen
kunt u een bezoek brengen aan onze Technical Support-atdeling
op de Web site van Quark op www.quark.nl.

Aanvullende informatie over QuarkXPress 4.1

e (Alleen voor QuarkXPress Passport voor Mac OS) De help-
bestanden voor QuarkXPress Passport zijn in versie 4.1
geupdate. Om deze bestanden daadwerkelijk te updaten,
moet u de map “Passport Help Files” op de QuarkXPress
Passport Updater CD-ROM openen. Selecteer het helpbe-
stand voor de door u gewenste taal en sleep-kopieer dit
naar de QuarkXPress Passport-programmamap op de harde
schijf van uw computer. Als er voor die taal al een ouder
helpbestand is geinstalleerd, moet u dit oudere helpbe-
stand door het nieuwe vervangen.

¢ (Alleen voor Mac OS) Naast het grote assortiment Quark
XTensions-modules dat door Quark wordt meegeleverd,
vindt u op de QuarkXPress CD-ROM ook een groot aantal
gratis en demo XTensions™modules van derden. Als u een
groot aantal XTensions gaat installeren, zult u aan het pro-
gramma QuarkXPress meer geheugen moeten toewijzen. In
Mac OS 8.1 of een lagere versie moet u daartoe het pro-
grammasymbool van QuarkXPress markeren en vervolgens
Archief - Info kiezen of drukken op & +I; in Mac OS 8.5
of een hogere versie moet u ook het programmasymbool

vervolgens de hoeveelheid geheugen in het veld Bij voor-
keur en sluit het dialoogvenster Info.

(Alleen voor Mac OS 9). Als een gebruiker gedefinieerd als
een Limited User (6 - Control Panels - Multiple Users)
toegang heeft tot een eerder geinstalleerd exemplaar van
QuarkXPress 4.x en deze probeert op te starten terwijl niet-
4.0 native QuarkXTensions-software is geinstalleerd, wordt
de niet-native QuarkXTensions-software niet geladen. Er ver-
schijnt een foutmelding en de gereedschappen in QuarkXPress
zijn uitgeschakeld. Om QuarkXPress te gebruiken in een Limi-
ted User account, moet u QuarkXPress opnieuw installeren
op het bureaublad van de Limited User of in de gebruikers-
map. Is QuarkXPress eenmaal via het inloggen als Limited
User opnieuw geinstalleerd, dan zal het programma correct
opstarten met niet-native 4.0 QuarkXTensions-software.

(Alleen voor Windows NT 3.51 ) Er kunnen diverse pro-
blemen optreden als u QuarkXPress 4.1 draait onder
Windows NT 3.51.

Aanvullende informatie over de PDF Filter QuarkXTensions-
software
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Onder “PDF Filter 1.3” in “QuarkXPress 4.1 in vogelvlucht”
zijn de laatste twee alinea’s van stap 6 in “De voorkeuren
instellen voor het printen van het PDF-bestand” niet cor-
rect. U kunt deze beide alinea’s overslaan.
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e Gegevens onder Meer informatie in het tabblad Illustraties Aanvullende informatie over Custom Bleeds QuarkXTensions-
in het dialoogvenster Gebruikte (Functies-menu) worden software
niet correct weergegeven wanneer het PDF Filter is geladen. * In een dubbelzijdig document produceren instellingen die

zijn ingevoerd in de velden Binnen en Buiten (Archief/
Bestand — Print - tabblad Aflopend) aan de binnen- en
buitenkant van het document niet de juiste aflopers wan-

e Het PDF Filter kan geen PDF-bestanden importeren waarin
geintegreerde CID 2-byte fonts (Japans, Koreaans of Chinees)

voorkomen.
neer in het tabblad Document in het dialoogvenster Print
¢ (Alleen voor Mac OS 8.5.1) Er is een compatibiliteitsprobleem het vakje Uitvouw is aangekruist.
tussen Mac OS 8.5.1, TrueType-fonts en LaserWriter 8.2.2 of
lagere drivers, of Adobe® PSPrinter™ 8.3.1 drivers. Wanneer Aanvullende informatie over DejaVu QuarkXTensions-
een PDF-bestand met TrueType-fonts onder Mac OS 8.5.1 software
wordt geéxporteerd met behulp van een van deze drivers, e (Alleen voor Mac OS 8.x) Om voor opdrachten in het Archief-
kan de computer gaan “hangen”. menu een standaardpad te activeren, moet u QuarkXPress
verlaten en vervolgens in het Apple-menu (®) de opdracht
Aanvullende informatie over QuarkLink QuarkXTensions- Regelpanelen ~ Algemeen kiezen. Vervolgens klikt u onder
software Documenten op de radioknop de door het programma inge-
e Eris een grens aan de lengte van een emailtje dat u kunt ver- stelde map of de map ‘Documenten’. Klik vervolgens in het
sturen met de QuarkLink™-software. Deze ligt op 32K (32.766 dialoogvenster Algemeen op het sluitvakje en start Quark
lettertekens). Als u deze grens heeft bereikt, kunt u geen tekst XPress opnieuw op.

meer invoeren in het dialoogvenster E-mail. Als u probeert in
het dialoogvenster E-mail tekst te plakken waardoor de grens
wordt overschreden, zal QuarkLink daarin zoveel mogelijk
tekens plakken totdat de grens fysiek is bereikt.

e Wanneer u de standaardinstelling voor Bestandslijst wijzigt,
ziet u vaak duplicaten van meest recent geopende documenten
wanneer u deze opent via Bestandslijst of Archief/Bestand —
Open. Om dit probleem op te lossen, kunt u het bestand
“Dejavu.prf” in de map Voorkeuren in de Systeemmap
onder Mac OS, of in de map “XTension” in uw QuarkXPress-
of QuarkXPress Passport-programmamap onder Windows
verwijderen.
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Aanvullende informatie over Guide Manager
QuarkXTensions-software

Als in een van de velden in het tabblad Stramienlijnen toe-
voegen in het dialoogvenster Guide Manager ongeldige
informatie wordt ingevoerd en vervolgens op Stramienlij-
nen toevoegen wordt geklikt, gaat QuarkXPress terug naar
het dialoogvenster Guide Manager zonder de foutmelding
te geven dat de door u ingevoerde informatie ongeldig is.

Als u klikt op Stramienlijnen verwijderen en vervolgens klikt
op Annuleren wanneer in het venstermenu Waar (Functies >
Guide Manager — tabblad Stramienlijnen verwijderen of
vergrendelen - onder Stramienlijnen verwijderen) de optie
Alle uitvouwen is gekozen, worden sommige hulplijnen ver-
wijderd. Dit treedt alleen op in dubbelzijdige documenten die
meer dan vier pagina’s tellen.

Aanvullende informatie over Scissors QuarkXTensions-
software

Als u een kader knipt waarin geindexeerde tekst staat, worden

alle indexingangen in dat kader verwijderd uit het Index-palet.

(Alleen voor Windows) Als u meerdere knipacties uitvoert op
een verticaal segment van een illustratiekader, worden de lijnen
tussen de knippunten niet langer weergegeven, maar u kunt ze
nog wel selecteren. Een oplossing kan zijn het kader een klein
beetje te roteren voordat u het segment gaat knippen.

Aanvullende informatie over Super Step and Repeat

QuarkXTensions-software

¢ (Alleen voor QuarkXPress Passport Extra talen) Als u gaat wer-
ken met Super Step and Repeat terwijl de programmataal is
ingesteld op een extra taal (Wijzig/Bewerken - Programma-
taal) zal QuarkXPress Passport “bevriezen”. Om dit probleem
op te lossen, kunt u de programmataal instellen op een stan-
daardtaal in QuarkXPress Passport voordat u Item - Super
Stap en herhaal Kkiest.
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Contact opnemen met Quark

Als u deelneemt aan een technisch ondersteuningsprogramma,
neem dan contact op met uw lokale Quark-kantoor of Quark
Full Service Distributor.

Zie voor een overzicht van Quark-kantoren en Quark Full
Service Distributors het bestand m.b.t. technische ondersteu-
ning op uw QuarkXPress CD-ROM.

Voor een bijgewerkt overzicht van Quark-kantoren en Quark
Full Service Distributors moet u klikken op de koppeling
“Contact opnemen met Quark” op de Web site van Quark
op www.quark.nl.

Breng voor productinformatie een bezoek aan de Web site
van Quark op www.quark.nl.

Stuur voor e-mailondersteuning m.b.t. QuarkXPress een
emailtje naar technical@quark.nl of MacTech@quark.com
of WinTech@quark.com.
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©1999 Quark Technology Partnership met betrekking tot con-
tent en uitvoering van dit materiaal. Alle rechten voorbehouden.

©1986-1999 Quark Technology Partnership wat betreft de tech-
nologie. Alle rechten voorbehouden.

De informatie in dit document mag niet worden gewijzigd,
verdeeld of anderszins verspreid in papieren of elektronische
vorm zonder voorafgaande schriftelijke toestemming van Quark
Technology Partnership of zijn licentiehouder Quark, Inc.

Handelsmerken

Quark, QuarkXPress, QuarkXPress Passport, XTensions en
QuarkXTensions zijn handelsmerken van Quark, Inc. en alle
verbindende daarbij aangesloten bedrijven, Reg. U.S. Pat. &
Tm. Off. en in veel andere landen. Het Quark-logo, QuarkLink
en andere handelsmerken die Quark, Inc. van tijd tot tijd
gebruikt, zijn handelsmerken van Quark, Inc. en alle verbin-
dende daarbij aangesloten bedrijven.

Adobe en PSPrinter zijn handelsmerken van Adobe Systems
Incorporated.

Alle andere handelsmerken zijn eigendom van hun respectieve
eigenaren.

m Pagina 50

“www | Onderwerpen] )]


http://www.quark.com

Versjonsmerknader for QuarkXPress og QuarkXPress Passport 4.1

‘A

AR

Dette dokumentet inneholder informasjon om endringer og til-
legg til programmene QuarkXPress™, QuarkXPress Passport™
og QuarkXTensions™ siden «En innfering i QuarkXPress 4.1» var
ferdig. «En innfering i QuarkXPress 4.1» er tilgjengelig som en
PDF-fil pd CD-ROM-en med QuarkXPress 4.1 eller QuarkXPress
Passport 4.1.

. Tilleggssprak for QuarkXPress Passport
. Siste nytt
. Hvordan kontakte Quark

. Juridiske merknader
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Tilleggssprak for QuarkXPress Passport

Orddeling er tilgjengelig for tilleggssprakene i QuarkXPress
Passport. Disse spradkene omfatter tsjekkisk, finsk, gresk, ungarsk,
polsk og portugisisk for Mac-OS, og finsk, ungarsk, polsk og
portugisisk for Windows.

Tilleggssprdkene finnes pa CD-ROM-en med oppdateringspro-
grammet for QuarkXPress Passport 4.1 Diss sprakene finnes
dessuten pd en egen CD-ROM. Ta kontakt med nermeste
Quark™-kontor eller Quark-forhandler som gir full service (se
under «<Hvordan kontakte Quark» i dette dokumentet, hvis du
vil vite hvordan du far tak i CD-ROM-en med tilleggssprakene.

- sides2 Cwvww | Emner 1]


http://www.quark.com

Versjonsmerknader for QuarkXPress og QuarkXPress Passport 4.1

pad hurtigmenyen Vis. Ok deretter mengden i feltet Anbefalt:,
og lukk dialogboksen Info.

Siste nytt

MERK Flere lgsninger er kanskje inkludert, og andre proble-

mer kan ha blitt oppdaget etter at dette dokumentet ble utgitt. .
Besgk derfor Quarks tekniske stgtteomrdde pa Quarks web-sted,
www.quark.dk, hvis du vil ha informasjon om de siste proble-
mene som er oppdaget.

(Gjelder bare Mac OS 9) Hvis en bruker, som er definert som
begrenset bruker (8 - kontrollpaneler - flerbrukere), har
tilgang til en tidligere installert kopi av QuarkXPress 4.x og pro-
ver a starte den mens QuarkXTensions-programvare som ikke er
skrevet for 4.0, er installert, lastes ikke den QuarkXTensions-
programvaren som ikke er skrevet for 4.0. En feilmelding vises
og QuarkXPress-verktgyene deaktiveres. Installer QuarkXPress
pa skrivebordet eller i brukermappen til den begrensede bruke-
ren for & kunne bruke QuarkXPress i en begrenset brukerkonto.
Nér QuarkXPress er installert pa nytt og brukeren er palogget
som begrenset bruker, startes programmet pd riktig mate med
QuarkXTensions-programvare som ikke er skrevet for 4.0.

Tilleggsinformasjon om QuarkXPress 4.1

* (Gjelder bare QuarkXPress Passport for Mac OS): Hjelpefi-
lene for QuarkXPress Passport er oppdatert i versjon 4.1.
Disse filene oppdateres ved a apne mappen “Passport Help
Files” pa CD-ROM-en med oppdateringsprogrammet for
QuarkXPress Passport. Finn hjelpefilen for det sprdaket
du vil ha, og dra-kopier den inn i programmappen for
QuarkXPress Passport pa datamaskinens harddisk. Hvis det
allerede er installert en gammel hjelpefil for det aktuelle
spraket, skal den gamle hjelpefilen erstattes med den nye.

¢ (Gjelder bare Windows NT 3.51) Forskjellige skjermpro-
blemer kan oppsta ved bruk av QuarkXPress 4.1 med

. i . ) Windows NT 3.51.
* (Gjelder bare Mac OS) I tillegg til en rekke av QuarkXTensions-

modulene som leveres av Quark, inneholder CD-ROM-en med
QuarkXPress ogsa mange XTensions™ som enten er gratis- eller
demomoduler fra tredjepart. Hvis du installerer et storre antall .

Tilleggsinformasjon om QuarkXTensions-programvaren
for PDF Filter
Under «PDF Filter 1.3» i «En innfgring i QuarkXPress 4.1» er

XTensions, ma du sannsynligvis oke minnetildelingen for
QuarkXPress. I Mac OS 8.1 eller eldre gjor du dette ved a velge
programsymbolet for QuarkXPress og velge Arkiv, Vis info
eller trykke pd 3 +1. I Mac OS 8.5 eller nyere velger du pro-
gramsymbolet for QuarkXPress og velger Arkiv, Vis info,
Hukommelse eller trykker pa 3 +I og velger Hukommelse
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e PDF Filter kan ikke importere PDF-filer som inneholder inne- Tilleggsinformasjon om QuarkXTensions-programvaren
bygde 2-bytes CID-skrifter (japanske, koreanske eller kinesiske). DejaVu

¢ (Gjelder bare Mac OS 8.x) Hvis du vil aktivere en standard-
bane for kommandoer pa menyen Arkiv, md du lukke Quark
XPress og deretter velge Kontrollpanel - Generelt pd Apple
(®)-menyen. Deretter klikker du pé valgknappen Folder that
is set by the application (Mappe som er innstilt av program-
met) eller Dokumentets mappe i omradet Dokumenter.
Klikk til slutt i lukkeruten i dialogruten Generelt, og start

Tilleggsinformasjon om QuarkXTensions-programvaren QuarkXPress pa nytt.

QuarkLink

¢ Det finnes en grense for hvor lang e-post du kan sende med
QuarkLink™-programvare. Grensen er pd 32 Kb (32.766 tegn).
Nar du denne grensen, kan du ikke skrive inn mer tekst i dialog-
ruten E-mail (e-post). Prgver du 4 lime inn tekst som forer til
at grensen overskrides, i dialogruten E-mail, limer QuarkLink
inn sd mange tegn som mulig til tekstgrensen nas.

¢ (Gjelder bare Mac OS 8.5.1) Det forekommer inkompatibili-
tet blant Mac OS 8.5.1, TrueType-fonter og LaserWriter 8.2.2-
drivere eller eldre, eller Adobe® PSPrinter™ 8.3.1-drivere. Nar
du eksporterer en PDF-fil som inneholder TrueType-fonter
under Mac OS 8.5.1 og bruker en av disse driverne, kan data-
maskinen krasje.

e Nar du endrer standardinnstillingene for File List (Filliste),
ser du kanskje duplikater av nylig dpnede dokumenter nér
du apner dem med enten File List eller Arkiv, Apne. Du
kan omga dette problemet ved & slette filen «Dejavu.prf» i
systemmappen > Valg i Mac OS, eller i mappen «XTension»
i programmappen for QuarkXPress eller QuarkXPress Passport
i Windows.

Tilleggsinformasjon om QuarkXTensions-programvaren

Custom Bleeds

e ] et dokument med motstdende sider, produserer ikke inn-
stillinger, som angis i feltene Indre og Ytre (Arkiv/Fil >
Skriv ut > kategorien Utfallende), de riktige innvendige og
utvendige utfallingene nar Oppslag er avmerket i dialogru-
ten Skriv ut i kategorien Dokument.

Tilleggsinformasjon om QuarkXTensions-programvaren

Guide Manager

e Hvis du angir ugyldig informasjon i ett av feltene i katego-
rien Add Guides (Legg til hjelpelinjer) i dialogruten Guide
Manager og deretter klikker pa Add Guides, er det mulig
at QuarkXPress gar tilbake til dialogruten Guide Manager
uten 4 vise en feilmelding om at den angitte informasjonen
er ugyldig.
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e Klikker du pd Remove Guides (Fjern hjelpelinjer) og deretter
klikker pa Avbryt nar All Spreads (Alle oppslag) er valgt pa
lokalmenyen Where (Hvor) (Annet >~ Guide Manager &
kategorien Remove or Lock Guides (Fjern eller las hjelpe-
linjer) & omrddet Remove Guides) blir noen hjelpelinjer
fjernet. Dette skjer bare i dokumenter med motstaende sider
og med mer enn fire sider.

Tilleggsinformasjon om QuarkXTensions-programvaren

Scissors

e Hvis du klipper en blokk som inneholder indeksert tekst, fjer-
nes alle indekserte ord i denne blokken fra paletten Indeks.

¢ (Gjelder bare Windows) Hvis du klipper opp et vertikalt seg-
ment i en bildeblokk i flere biter, er det mulig at linjene mel-
lom klippene ikke vises lenger, men du kan fremdeles velge
dem. En lgsning pé dette problemet er 4 dreie boksen litt for
du klipper segmentet.

Tilleggs informasjon om QuarkXTensions-programvaren

Super Step and Repeat

¢ (Gjelder bare tilleggssprak for QuarkXPress Passport) Bruk
av Super Step and Repeat mens programspraket er innstilt
pa et tilleggssprak (Rediger -~ Programsprak), forer til at
QuarkXPress Passport henger seg opp. En mate & lgse dette
problemet pd er a endre programspraket til et standard
QuarkXPress Passport-sprak for du velger Objekt - Super
Step and Repeat.
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Hvordan kontakte Quark

Hvis du er med i en kundestotteplan, kan du kontakte din lokale
Quark-avdeling eller Quark-distributer som yter full service.

Du finner en liste over Quark-kontorer og Quark-distributerer
med full service i kundestgttefilen pd CD-ROM-en med
QuarkXPress.

Du finner en oppdatert liste over Quark-kontorer og Quark-
distributerer som gir full service, ved a klikke pa koblingen
«Sadan kontakter du Quark» pa Quarks Web-omrade
www.quark.dk.

Hvis du vil ha produktinformasjon, kan du besgke Quarks
Web-omrade pa www.quark.dk.

Hvis du vil ha kundestgtte for QuarkXPress via epost, kan du
sende en melding til techsupport@quark.dk, MacTech@quark.com
eller WinTech@quark.com.
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Juridiske merknader

©1999 Quark Technology Partnership med hensyn til innhol-
det og oppsettingen av dette materialet. Med enerett.

©1986-1999 Quark Technology Partnership med hensyn til
teknologien. Med enerett.

Informasjonen i dette dokumentet kan ikke endres, distribueres
eller mangfoldiggjores, verken pa papir eller i elektronisk for-
mat uten skriftlig tillatelse av Quark Technology Partnership
eller selskapets lisensinnehaver Quark, Inc.

Varemerker

Quark, QuarkXPress, QuarkXPress Passport, XTensions og
QuarkXTensions er varemerker for Quark, Inc. og alle andre
tilsluttede selskaper, Reg. U.S. Pat. & Tm. Off. og i mange
andre land. Quark-logoen, QuarkLink, og andre varemerker
som Quark, Inc. eventuelt adopterer fra tid til annen, er vare-
merker for Quark, Inc., og alle tilsluttede selskaper.

Adobe og PSPrinter er varemerker for Adobe Systems Incorporated.

Alle andre varemerker tilhorer de respektive eierne.
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Detta dokument innehéller upplysningar om dndringar och
tilldgg i programmen QuarkXPress™, QuarkXPress Passport™ och
QuarkXTensions™ som skett sedan “Handbok for QuarkXPress 4.1”
gavs ut. Du hittar "Handbok for QuarkXPress 4.1” som en PDF-fil
pa cd-skivan med QuarkXPress 4.1 eller QuarkXPress Passport 4.1.

. Tillaggssprak for QuarkXPress Passport
. Upplysningar i sista minuten
. Kontakta Quark

. Juridiska meddelanden
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Tillaggssprak for QuarkXPress Passport

Avstavning finns nu tillgangligt for QuarkXPress Passport
tillaggssprak, vilket innefattar tjeckiska, finska, grekiska,
ungerska, polska och portugisiska for Mac OS och finska,
ungerska, polska och portugisiska for Windows.

Tillaggsspraken finns pa cd-skivan med QuarkXPress Passport 4.1
uppdateringsprogram. De finns dven pa separata cd-skivor
med tillaggssprak. Kontakta ndrmaste Quark™-kontor eller
Quark-aterforsdljare for upplysningar om hur du far tag pa en
cd-skiva med tillaggssprak (se avsnittet "Kontakta Quark” i
detta dokument).
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OBS! Efter det att detta dokument publicerades kan det
hidnda att ytterligare rattelser har skett och att andra problem
har upptéckts. De senaste upplysningarna om kianda problem
finns i omrddet for teknisk support pa Quarks webbsida pa
www.quark.dKk.

Ytterligare upplysningar om QuarkXPress 4.1

¢ (Endast QuarkXPress Passport for Mac OS) Hjdlpfilerna for
QuarkXPress Passport har uppdaterats i version 4.1. Du kan
uppdatera dessa filer genom att Oppna mappen “Passport Help
Files” pa cd-skivan med QuarkXPress Passport Uppdaterare.
Leta reda pa hjdlpfilen for ditt sprak och dra-kopiera filen till
programmappen QuarkXPress Passport pd datorns harddisk.
Om det en dldre version av hjidlpfilen redan finns pa detta
sprak ska du ersdtta den gamla hjélpfilen med den nya.

e (Endast Mac OS) Cd-skivan med QuarkXPress innehaller for-
utom flera QuarkXTensions-moduler som tillhandahalles av
Quark, dessutom méanga XTensions™-moduler fran tredje
man som dr kostnadsfria eller demoprogram. Om du instal-
lerar ett stort antal XTensions behover du formodligen 6ka
minnestilldelningen for QuarkXPress. I Mac OS 8.1 eller tidi-
gare kan du gora detta genom att markera programsymbolen
tor QuarkXPress och vilja Arkiv - Visa info eller genom att
trycka pa 3 +1; i Mac OS 8.5 eller senare ska du markera pro-
gramsymbolen for QuarkXPress och vilja Arkiv - Visa
info >~ Minne eller trycka pa 3 +I, och vilja Minne i

popupmenyn Visa. Oka sedan virdet i filtet Maximum
och sting dialogrutan Info.

e (Endast Mac OS 9) Om en anvdndare med definitionen
Limited User (Begransad anviandare) (& - Instidllningar >
Multiple Users (Flera anvidndare)) har tillgang till en tidigare
installerad kopia av QuarkXPress 4.x och forsoker starta pro-
grammet ndr ett QuarkXTensions-program som inte har
utvecklats for 4.0 installeras, gar det inte att ladda Quark
XTensions-programmet som inte har utvecklats for 4.0, ett
felmeddelande visas och verktygen i QuarkXPress deakti-
veras. Om du vill anvanda QuarkXPress i ett begrdnsat
anvdndarkonto ska du installera om QuarkXPress i map-
pen Limited User (Begrdnsad anvidndare) pa skrivbordet
eller i anvandarmappen. Nar QuarkXPress har installerats
om med den begriansade anviandarens inloggning kommer
det att starta pd ratt sitt med QuarkXTensions-programmet
som inte har utvecklats for 4.0.

e (Endast Windows NT 3.51) Det kan uppstd olika typer av
visningsproblem nér du kor QuarkXPress 4.1 med Windows
NT 3.51.

Ytterligare upplysningar om QuarkXTensions-programmet

PDF Filter

e [ avsnittet "PDF Filter 1.3” i "Handbok for QuarkXPress 4.1” ar
de sista tvd styckena i steg 6 i “Ange installningar for utskrift av
PDF-filen” felaktiga. Bortse fran dessa stycken.
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e Det kan hdnda att omradet Ytterligare info i fliken Bilder i
dialogrutan Anviandning (menyn Ovrigt) visas pé fel sitt nar
PDF Filter dr laddat.

e PDF Filter kan inte importera PDF-filer som innehdller
inbaddade CID 2-bytes (japanska, koreanska eller kinesiska)
teckensnitt.

e (Endast Mac OS 8.5.1) Det foreligger ett kompatibilitets-
problem mellan Mac OS 8.5.1, TrueType-teckensnitt och
LaserWriter 8.2.2 eller tidigare drivrutiner eller Adobe®
PSPrinter™ 8.3.1 drivrutiner. Ndr du exporterar en PDF-fil
som innehaller TrueType-teckensnitt under Mac OS 8.5.1
med en av dessa drivrutiner kan det hdanda att datorn kraschar.

Ytterligare upplysningar om QuarkXTensions-programmet

QuarkLink

e Lingden pé de e-postmeddelanden du kan skicka med pro-
grammet QuarkLink™ar begrinsad. Gransen ligger vid 32K
(32.766 tecken). Om du uppnar denna grans kan du inte skriva
in mer text i dialogrutan E-post. Om du forsoker Klistra in text
som skulle 6verskrida gransen i dialogrutan E-post kommer
QuarkLink att klistra in sd manga tecken som mojligt tills
textgransen nas.

Ytterligare upplysningar om QuarkXTensions-programmet

Custom Bleeds

e | dokument med motstdende sidor ger inte de instdllningar
som anges i fdlten Inre och Yttre (Arkiv - Skriv ut > fli-
ken Utfallning) ritt inre och yttre utfallning nar Uppslag
ar markerat i fliken Dokument i dialogrutan Skriv ut.

Ytterligare upplysningar om QuarkXTensions-programmet

DejaVu

¢ (Endast Mac OS 8.x) Innan du kan aktivera standardsokva-
gen for kommandona i menyn Arkiv mdste du avsluta
QuarkXPress och sedan vilja Installningar > Diverse
installningar i menyn Apple (), och klicka pa alternativ-
knappen for Folder that is set by the application (den mapp
som dr angiven i programmet) eller Dokumentmappen i
omradet Dokument. Klicka sedan pa stangningsrutan i dia-
logrutan Diverse installningar och starta om QuarkXPress.

e Ndr du dndrar standardinstédllningen for File List (Fillista),
kan det handa att kopior av dokument som nyligen 6ppnats
visas nar du oppnar dem med kommandot File List (Fillista)
eller Fil > Oppna. Du kan undvika problemet genom att ta
bort filen "Dejavu.prf” som finns i Systemmappen - Pro-
graminstéllningar pd Mac OS, eller i mappen ”XTension” i
mappen med programmet QuarkXPress eller QuarkXPress
Passport i Windows.
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Ytterligare upplysningar om QuarkXTensions-programmet Ytterligare upplysningar om QuarkXTensions-programmet
Guide Manager Super Step and Repeat
* Om du skriver in ogiltig information i ett av félten i fliken Lagg e (Endast for QuarkXPress Passport tillaggssprak) Om du

till stodlinjer i dialogrutan Guide Manager och sedan klickar
pa Lagg till stodlinjer, kan det hdnda att QuarkXPress dtergar
till dialogrutan Guide Manager utan att visa ett felmeddelande
som anger att den inskrivna informationen ar felaktig.

* Om du klickar pa Ta bort stodlinjer och sedan klickar pa

anvander Super Step and Repeat ndr programspraket ar
instdllt pd ett tillaggssprak (Redigera - Programsprak)
kommer QuarkXPress Passport att frysa. Du kan undvika
detta problem genom att dndra programsprdket till ett av
standardsprdken i QuarkXPress Passport innan du viljer

Avbryt nir Alla uppslag ir valt i popupmenyn Var (Ovrigt > Objekt > Super Step and Repeat.

Guide Manager — fliken Ta bort eller las stodlinjer -~ omra-
det Ta bort stodlinjer), kommer vissa stodlinjer att tas bort.
Detta intrdffar bara i dokument med motstadende sidor som har
mer dn fyra sidor.

Ytterligare upplysningar om QuarkXTensions-programmet

Scissors

e Om du Kklipper ut ett block som innehéller indexerad text
kommer alla indexerade ord i detta block att tas bort fran
paletten Index.

e (Endast Windows) Om du klipper ut flera omraden i ett verti-
kalt segment av ett bildblock kan det hidnda att linjerna mellan
urklippen inte visas langre, men du kan fortfarande markera
dem. Du kan undvika detta problem genom att rotera blocket
lite grann innan du borjar klippa ut segmentet.
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Kontakta Quark

Om du har en teknisk support-plan, kontakta ditt lokala Quark-
kontor eller Quark-distributoren.

I den tekniska supportfilen pa cd-skivan med QuarkXPress finns
en lista med Quark-kontor och Quark-dterforsaljare.

Om du vill se en uppdaterad lista 6ver Quark-kontor och Quark-
aterforsaljare ska du klicka pa lanken ”"Saddan kontakter du Quark”
péa Quarks webbplats pa www.quark.dk.

Produktinformation finns pa Quarks webbplats pa
www.quark.dk.

Du kan fa support fér QuarkXPress via e-post genom
att skicka ett meddelande till techsupport@quark.dk,
MacTech@quark.com eller WinTech@quark.com.
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Juridiska meddelanden

©1999 Quark Technology Partnership med avseende pd inne-
hallet i och arrangemanget av detta material. Med ensamratt.

©1986-1999 Quark Technology Partnership med avseende pa
tekniken. Med ensamratt.

Upplysningarna i detta dokument fér inte dndras, distribueras
eller spridas i pappers- eller elektronisk form utan tidigare skrift-
ligt tillstdnd frdn Quark Technology Partnership eller dess licens-
innehavare Quark, Inc.

Upplysningar om varumarke

Quark, QuarkXPress, QuarkXPress Passport, XTensions och Quark
XTensions dr varumarken som tillhor Quark, Inc. och alla tillho-
rande dotterbolag, Reg. U.S. Pat. & Tm. Off. Dessutom i mdnga
andra linder. Logotypen for Quark, QuarkLink och andra varu-
marken Quark, Inc. emellanat kan anta, dr varumarken som
tillhor Quark, Inc. och alla tillhorande dotterbolag.

Adobe och PSPrinter dar varumarken som tillhér Adobe Systems
Incorporated.

Alla andra varumarken tillhor respektive dgare.
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